Microsoft Outlook 2003 Tutorial

Using the Keyboard Instead of the Mouse



Pressing ALT+S sends a message, which is faster than moving your hand to the mouse, moving the pointer, and clicking Send.

	
	LESSON TEXT

Because the primary concern for most Outlook users is e–mail, this lesson will concentrate on that as well as look at how to move around the various areas of Outlook. (The second lesson is about the calendar and the third about contacts.)

Note   In many areas of Outlook, more than one keyboard shortcut exists to carry out the same action. Where both of these shortcuts are in common usage, both will be mentioned; use the one that makes the most sense to you. Otherwise, only the most commonly used shortcut will be mentioned.


· First things first: move around Outlook
· [image: image1.png]


Press CTRL+1 for Mail 
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Press CTRL+2 for Calendar 
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Press CTRL+3 for Contacts 
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Press CTRL+4 for Tasks 
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Press CTRL+5 for Notes 
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Press CTRL+6 for Folder List 
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Press CTRL+7 for Shortcuts 

The keyboard shortcuts to move around Outlook.

	
	COURSE TEXT

How would you move from your mail to the calendar or contacts using the keyboard? Although it's possible to move between the various areas of Outlook by using the Go menu or the Navigation Pane, there is another much simpler way in Microsoft Office Outlook® 2003.

Some new keyboard shortcuts have been introduced; they are so useful, you'll wonder how you ever coped without them. Switching between the various areas of Outlook is now very simple. To move to Mail, for example, just press CTRL+1—it's so easy.

The new keyboard shortcuts are shown in the list above.


Navigate around Mail
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F6 cycles between the three main areas.
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 The Navigation Pane.
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 The active folder. Here it's the Inbox, but it could be any folder.
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 The Reading Pane.

	COURSE TEXT

The three main areas of the Outlook window are the Navigation Pane, the active folder pane, and the Reading Pane. Pressing F6 will move you between these panes and SHIFT+F6 will cycle backwards through them.

By default the Navigation Pane is on the left of the Outlook window, whether you are in Mail, Contacts, Calendar or whatever. The active folder area shows the Inbox or whichever folder you have open. The Reading Pane gives you a chance to look at message contents without opening the message. 

If you have a message open, it will be in a separate window.

Note   There are various ways of displaying your e–mail messages. Don't panic if the images and descriptions of e–mail in this course are different to the way you have yours set up. The course shows the default settings for Outlook, but the keyboard shortcuts work in whatever layout you are using.


Read your messages
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 Use the UP ARROW key to move to the next message in the folder.
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 Use the DOWN ARROW key to move to the previous message in the folder.
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 Press ENTER to open a message.
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 Press ESC to close the message.

	
	COURSE TEXT

Now that you know how to move around in Outlook, it's time to explore using the keyboard with e-mail.

Although you'll probably spend most of your time reading messages in your Inbox, you can move to any e-mail folder by using CTRL+Y.

Move between messages in a folder by using the arrow keys. If you want to open the message rather than just read it in the Reading Pane, move to it in the folder and then press ENTER.

When you have finished reading the message, press ESC and you will be back in the Outlook window. However, if you have several messages that you want to open, you don't have to go back to the Outlook window every time. From the open message window, press CTRL+COMMA to open the next message and CTRL+PERIOD to open the previous message.

If you want to print a message, the universal CTRL+P will print it just as it prints any other document in Microsoft® Office. 

Even these few simple keyboard shortcuts will decrease the time it takes to read your messages.


Send a message
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All the standard text manipulation shortcuts work:

[image: image18.png]


 CTRL+N to open a new message.
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 CTRL+B for boldface.
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 CTRL+I for italic.

[image: image21.png]


 CTRL+U for underline.
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 ALT+S to send a message.

	
	COURSE TEXT

When you want to create a new message, you have a choice of shortcuts; which one you use is a personal preference based on how you work. 

· CTRL+SHIFT+M opens a new message window in whatever area of Outlook you are currently using. 

· CTRL+N opens a new message window when you are in Mail. If you are in Calendar, it opens a new appointment; if you are in Contacts it opens a new contact; and so on. 

· ALT+N opens the New submenu, where you can create a new message, appointment, meeting request, or choose other Outlook options. 

Decide which shortcut will be best for you and remember that one. You can create an entire message with just the keyboard:

Action

Keyboard Shortcut

Remember

Open a new message

CTRL+SHIFT+M or CTRL+N or ALT+N

M for Message or N for New.

Move around fields in the new message window

TAB

Works in the same way as any Office dialog box.

Look up an e–mail address

CTRL+SHIFT+B

B for book, as in Address Book.

Check validity of an address

CTRL+K

Is it OK?

Format text

Standard formatting shortcuts. For example, CTRL+B for bold.

B for Bold, I for Italic, U for Underline, and so on.

Send a message

ALT+S 

S for Send.





Reply or forward a message
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Send a message by using ALT+S, reply to a message by using CTRL+R, and forward a message by using CTRL+F.

	
	COURSE TEXT

You can reply to and forward a message from a folder with the message selected or from an open message window. As with many areas of Outlook, there is more than one keyboard shortcut to accomplish an action. 

You can either use ALT+ the underlined letters indicated on the Standard toolbar, as you would with items on the menu bar (for example, ALT+R to reply), or you can use the normal keyboard shortcuts:

Action

Keyboard Shortcut

Remember

Reply to a message

CTRL+R 

R for Reply.

Reply All

CTRL+SHIFT+R 

SHIFT+R is like replying but for more people so there are more keys.

Forward a message

CTRL+F 

F for Forward.

When you start to use keyboard shortcuts, it might be easier to use ALT+ the underlined letters on the toolbar buttons because you have a visual prompt for remembering the keys. However, either way works—use the one that you prefer.

Note    Toolbars adjust as you use them and buttons can "drop off." Remember this if you intend to use the toolbar shortcuts, because if the button is not visible, the shortcut won't work. For more information about adjusting toolbar buttons, see Help.



Organize and store your messages
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 Use the UP ARROW and DOWN ARROW keys to move between folders.
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 The RIGHT ARROW key expands a folder to reveal the subfolders.
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 The LEFT ARROW key collapses the folder tree to hide the subfolders.

	
	COURSE TEXT

Keeping your messages organized can be very important. Some people set up complex filing systems so that they can find a particular message when they need to.

Moving messages between folders is easy. With a message selected, press CTRL+SHIFT+V to open the Move Items dialog box. Then move around the folder tree in the dialog box to highlight the destination folder by using the UP ARROW and DOWN ARROW keys.

You can move around the dialog box by using the TAB key, as with other Office dialog boxes. If you have a filing system set up with subfolders, you can expand or collapse the subfolders by using the RIGHT ARROW and LEFT ARROW keys. You can try this out in the practice session.

There are two ways to create a new folder: either use the New folder button in the Move dialog box or use the shortcut CTRL+SHIFT+E.

Perhaps you have a message you don't want to keep? Well, deleting is simple. Select the message or open the message, and then press the DELETE key or press CTRL+D. If you want to permanently delete a message, select it in the Inbox and press SHIFT+DELETE. You will get a message asking if you're sure, because you cannot retrieve permanently deleted messages.

Action

Shortcut

Remember

Delete a message

CTRL+D

D for Delete

Permanently delete a message

SHIFT+DELETE

Be extra sure before you delete
Move a message

CTRL+SHIFT+V

SHIFT+V for shift oVer

Move around a folder tree

The arrow keys

You can probably remember this one without any help

Create a new folder

CTRL+SHIFT+E

E for an Extra folder





Attachments
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To add an attachment:
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 Press ALT+I to open the Insert menu.
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 Press L to insert a File.

	
	COURSE TEXT

Attachments are a widely used feature of Outlook because they are a common way for people to send and receive files. It's easy to send a file as an attachment by using the keyboard, as you can see in the illustration on the left.

To send another e-mail message as an attachment, use the Item command (press E) on the Insert menu (ALT+I).

Note    If you are using Microsoft Word as your mail editor and you want to add another message as an attachment, you have to use the Insert File button [image: image31.png]


. The exact details of how to do this are in the Quick Reference Card.

Reading an attachment is not the easiest thing to do using keystrokes. The best practice is to open the attachment from a closed message. In a folder, select the message which has the attachment, press SHIFT+F10, select View Attachments by pressing H, use the arrow keys to select the required attachment (there could be more than one), and then press ENTER to open the attachment. 

If you want to open an attachment from within a message, it's a bit more complicated. How you see an attachment in a message depends on the message format, whether it's Plain Text, RTF (Rich Text Format), or HTML (Hypertext Markup Language).

Read an attachment in an RTF message    The attachment appears in the body of the message. Move to the attachment by using the arrow keys, select it by using SHIFT+LEFT ARROW or SHIFT+RIGHT ARROW, press SHIFT+F10 to open the shortcut menu, and then select Open by pressing O.

Read an attachment in a Plain Text or HTML message    From the open message, press SHIFT+TAB to move into the attachment area of the message header, select the attachment with SHIFT+LEFT ARROW, press SHIFT+F10 to display the shortcut menu, and then type O for Open.

Save an attachment    From the open message, use the Save Attachments command (press N) on the File menu (ALT+F).


Practice Using the keyboard with mail



Press SHIFT+TAB to put the focus in this window, so that you can scroll through the instructions.

At some point you will want to reach for your mouse and scroll down these instructions. Don’t. Press ALT+TAB to move the focus to the instructions and then press the DOWN ARROW to move down the instructions. Press ALT+TAB to return to the Outlook window.

In this practice session you will send messages to your own e–mail address so that you don't fill someone else's Inbox with your test messages.

Exercise 1: Send a message

1. Open a new message by pressing CTRL+SHIFT+M. 

2. Enter your own e–mail address in the To line. 

3. Press the TAB key twice to move to the Subject line. 

4. Type Practice message. 

5. Press the TAB key to move the insertion point into the message window. 

6. Type a test sentence. Write whatever you want. 

7. Select a word in your test sentence by holding down the SHIFT key and pressing the RIGHT ARROW OR LEFT ARROW keys. Make that word bold by pressing CTRL+B. 

8. When you are happy with your message, press ALT+S to send it. 

Exercise 2: Reply to a message

Wait until the message you sent in Exercise 1 has arrived before you proceed.

1. If you're in another area of Outlook, such as Calendar or Contacts, press CTRL+1 to get to Mail. 

2. If the focus isn't in the Inbox, press F6 until it is, then use the UP ARROW and DOWN ARROW keys until the focus is on the newly arrived practice message. 

3. Press CTRL+R to reply to the message. 

A message window will open and the subject line will start with RE:.

4. The insertion point will be in the message window. Type in a test sentence. 

Tip    If you want to get into the message header information to change or add to the subject or addressees, press SHIFT+TAB.

5. Press ALT+S to send the message. 

Exercise 3: Forward a message

Forward the message sent in Exercise 1 to yourself.

Hint    Follow the same steps as you did to reply to a message, but use the forward shortcut (CTRL+F) rather than the reply shortcut.

You'll know that you have done everything correctly if the subject of the new message starts with FW:. Remember to enter your own e–mail address in the To line and to press the TAB key to move the insertion point into the message window.

Exercise 4: Read, delete, and file messages

1. If you're in another area of Outlook, such as Calendar or Contacts, press CTRL+1 to get to Mail. 

2. If the focus isn't in the Inbox, press F6 until it is, then use the UP ARROW and DOWN ARROW keys to move the focus to the most recent new message. 

3. Press ENTER; the message window opens. 

4. Press CTRL+PERIOD to read the previous message. 

5. Press CTRL+COMMA to return to the most recent message. 

6. Move through the messages using the shortcuts until you find the first test message that you sent yourself. Delete this message by pressing CTRL+D. 

7. Now, let's move the second test message to the Deleted Items folder. Use the UP ARROW or DOWN ARROW keys to move the focus to the message. Press CTRL+SHIFT+V; the Move Item to dialog box opens. 

8. Move around the folder tree in the dialog box by using the arrow keys. The UP ARROW and DOWN ARROW keys move up and down the list. If there are subfolders in the folder tree, the RIGHT ARROW key expands the folders and the LEFT ARROW KEY collapses them. 

9. When the focus is on the Deleted Items folder, press ENTER. 

10. Delete the last test message that you sent to yourself by following the same steps as you did to delete the earlier message. 

All of the messages you have deleted will now be in your Deleted Items folder (they'll stay there until the folder is emptied). You can read and move items in the Deleted Items folder with the same keyboard shortcuts as any other folder. So, if you ever delete something by accident, you can get it back.

Calendar
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Use keyboard shortcuts in the Outlook Calendar.

	COURSE TEXT

Another important feature of Outlook is the calendar. It can act as your appointment book, keeping you organized, even sending you reminders for meetings.

Just as with e–mail, keyboard shortcuts can be used to move around in the calendar and to quickly move between appointments or time periods. You can also send and reply to meeting requests and schedule an appointment in your calendar.

In this lesson, as in the last, we'll look first at how to move around before looking at some specific shortcuts for meetings and so on.



Look at your calendar
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 Underlined letters on the toolbar indicate keyboard shortcuts.
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 Use the TAB key to move between appointments.
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 Use the arrow keys to move between times and days.

	
	COURSE TEXT

In the last lesson you learned so much about e–mail that you may not remember that you can switch to Calendar by pressing CTRL+2. 

Within Day/Week/Month view in Calendar, there are four views: Day, Work Week, Week, and Month. You can move back to today's date in any view. Use ALT+ the underlined letter in the Standard toolbar buttons to change the view (for example, ALT+W). Remember: if the specific buttons aren't visible on your toolbar, then the shortcut won't work. Also, there are shortcuts that move to Month and Week view regardless of the toolbar buttons, as you can see in the following table:

Action

Shortcut

Remember

Change calendar to week

ALT+HYPHEN

A python (to rhyme with hyphen) isn't weak (week). Get it? 

Change calendar to month

ALT+EQUAL SIGN

Why aren't the days in a month equal? 

Change calendar to see specific number of days

ALT+ the number of days (for example, ALT+5 shows five days)

Just the number—this one's easy.

Move to a specific date

CTRL+G

G for Go to date.

To move between the Navigation Pane and the Calendar, use F6 as you did in Mail. Then, when you are in the Calendar pane, you can move around the days and time slots on the calendar by using the arrow keys.

To move between appointments, use the TAB key. To change the subject of an appointment, type directly into the item. If you want to change other details about the item, press ENTER to select it and then SHIFT+F10 to get to its shortcut menu. In the shortcut menu you can choose from a range of options concerning that meeting or appointment, including delete, label, open, and so on.


Make an appointment or meeting request
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Use the TAB key to move around the various boxes in the Appointment window. Select the available commands by using ALT+ the underlined letters indicated.

	
	COURSE TEXT

A valuable feature of Outlook is being able to make meetings and appointments, which are then entered in the calendar. Meetings and appointments are similar to messages: you can create new ones and reply to ones that you receive. Once again, you can carry out these actions just by using the keyboard.

To create a new appointment, press CTRL+SHIFT+A, or simply CTRL+N if you are already in Calendar. This will enter the appointment in your calendar only; to create a new meeting request and invite other people, press CTRL+SHIFT+Q. This will be sent to whoever you enter in the To line as well as entered into your own calendar.

You can fill out the appointment or meeting details in the same way as you write a message. For example, move about using the TAB key, use CTRL+K to check names, use all the normal text formatting shortcuts, and so on. To check whether everyone is free for your meeting, use CTRL+TAB to look at the Scheduling tab.

Press ALT+S when you have finished filling in your meeting or appointment details. This sends a meeting request or saves and closes an appointment. How simple—it's the same keys as sending a message.

Action

Shortcut

Remember

Create a new appointment

CTRL+SHIFT+A or CTRL+N 

A for Appointment or N for New

Create a new meeting request

CTRL+SHIFT+Q

Q for Quite a lot of people come to meetings

Send a meeting request 

ALT+S

S for Send

Save and close an appointment

ALT+S

S for Save





Reply to a meeting request
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Use ALT+ the underlined letters on the Standard toolbar to reply to meeting requests.

	
	COURSE TEXT

You now know all about sending out your own meeting requests, but what if someone sends you one? Well, accepting or declining a request couldn't be easier. Open the meeting request as you would any other e-mail message. Then, accept by pressing ALT+C, use ALT+N to tentatively accept, or decline by using ALT+D.

If you want to attend a meeting but the time isn't convenient, then propose a new time by using ALT+S, as indicated on the Standard toolbar underlined letter.


Practice Using the keyboard with the Outlook Calendar



Press SHIFT+TAB to put the focus in this window, so that you can scroll through the instructions.

At some point you will want to reach for your mouse and scroll down these instructions. Don’t. Press ALT+TAB to move the focus to the instructions and then press the DOWN ARROW to move down the instructions. Press ALT+TAB to return to the Outlook window.

Exercise 1: Change calendar views

1. If you're in another area of Outlook, such as Mail or Contacts, press CTRL+2 to get to Calendar. Make a note of what view your calendar is in at the moment; week, month, day. 

2. View the calendar in a monthly layout by pressing ALT+EQUAL SIGN. 

3. Change the calendar to the full week view. 

Hint    Use one of two shortcuts: either ALT+HYPHEN or ALT+ the underlined letter on the Week toolbar button. Be careful to get the Week button and not, Work Week.

4. Look at two days on the calendar view. 

Hint    To look at a certain number of days, press ALT+ the number of days.

5. Change the calendar view to your normal setting. 

Exercise 2: Make an appointment

1. Press ALT+O to move the focus to today. 

2. To open the new Appointment dialog box, press CTRL+SHIFT+A. 

3. Enter a subject: Practice appointment. 

4. Move to the Start time list by pressing the TAB key. Enter a start time of an hour from now by typing the figures in the box. 

Tip    If you accidently move past a field you want, pressing SHIFT+TAB will take you back again.

5. Save and close the appointment by pressing ALT+S. 

Exercise 3: Modify appointment details

1. In Calendar, move to the appointment you have just made by pressing the TAB key. 

2. Change the subject of the appointment to "Training" by typing in the appointment. Then press ENTER. 

3. Press ENTER again, to open the Appointment window, where you can edit all the appointment details (not just the subject). 

4. Delete the appointment by pressing CTRL+D. 


Contacts
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Use keyboard shortcuts with your contacts.

	AUDIO TEXT

The third area of Outlook that this course looks at is contacts. After all, what's the point in being able to send messages and meeting requests to people if you can't keep information about them up to date? The Contacts folder is basically your personal address book, where you can keep all the details you need about various people.

Find out how to use the keyboard to add a new contact, move around the Contact Details dialog box, and also how to look up a contact.



Look up a contact
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You can move between entries in the contacts using the arrow keys.

[image: image41.png]


 The DOWN ARROW key moves down to the next contact.
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 The RIGHT ARROW key moves to the next column. The LEFT ARROW key would move back again.
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 The UP ARROW key moves up to the previous contact.

	
	COURSE TEXT

To switch to Contacts use CTRL+3. You can use this shortcut from any other place in Outlook: Mail, Calendar, Tasks, and so on.

The most useful keyboard shortcut when you are looking for a contact is F11. You can use F11 from anywhere in Outlook—you don't have to be in Contacts. However, it doesn't work if you have an item open such as a message or appointment window. F11 moves the focus to the Find a Contact box; just type in the name of the person you are looking for, press ENTER, and their details will appear.

You can move around the contacts in your list by using the arrow keys. This is important to remember because frequently the TAB key is used for moving around. To open a particular contact's details, move the focus to that contact and then press ENTER. Another way of finding a contact is to type the first letter of their name, so type D to find contacts whose names begin with D.



Add a new contact
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 Switch between tabs using CTRL+TAB.
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 Move around the entry boxes by using the TAB key.
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 Use ALT+ the underlined key to execute a command, or to move to that entry.

	
	COURSE TEXT

When you need to enter a new contact, press CTRL+SHIFT+C to open the Contact dialog box. Or, as with Mail and Calendar, if you are already in the Contacts folder you can just press CTRL+N for a new entry.

The dialog box can be navigated in exactly the same way as other dialog boxes in Office: use CTRL+TAB to switch between the tabs, the TAB key to move between the various entry boxes sequentially, and ALT+ underlined keys to move directly to a particular box or command.


Practice Using the keyboard with Contacts



Press SHIFT+TAB to put the focus in this window, so that you can scroll through the instructions.

At some point you will want to reach for your mouse and scroll down these instructions. Don’t. Press ALT+TAB to move the focus to the instructions and then press the DOWN ARROW to move down the instructions. Press ALT+TAB to return to the Outlook window.

Exercise 1: Add a new contact

1. Open the Contact dialog box to create a new contact by pressing CTRL+SHIFT+C. 

2. Enter the following details in the dialog box: 

· Name: Linda Meisner 

· Business phone number: 555 0111 

· Business fax number: 555 0112 

· E–mail address: Use your own e–mail address 

Hint    Move around the dialog box by pressing the TAB key. Use ALT+ any underlined key to jump straight to that command or box. CTRL+TAB will move to the other tabs in the dialog box.

3. When you have finished entering the details, press ALT+S to save and close the dialog box. You'll use the contact you created in the next exercise. 

Exercise 2: Look up a contact

You will use two different methods of looking for a contact.

This exercise assumes that you already have some contacts entered in your list. If you don't have any contacts, other than the one you created in Exercise 1, you can still do this exercise but it will be very simple.

1. If you're in another area of Outlook, such as Mail or Calendar, press CTRL+3 to get to the Contacts folder. 

2. If the focus isn't in the contacts pane, press F6 until it is. 

3. Move around the contacts using the arrow keys, until you find the contact, Linda Meisner, that you created in Exercise 1. Press ENTER. 

4. Press ESC to close the dialog box. 

Now try a second method.

5. Press F11 to move to the Find a Contact box. Remember, you can use the F11 shortcut anywhere in Outlook—not just Contacts. 

6. Enter the name of the contact, Linda Meisner, that you created in Exercise 1 and then press ENTER. 

The dialog box opens with the contact details.

7. Now delete the contact by pressing CTRL+D. 

	Top of Form

Quick Reference Card
Keyboard shortcuts to move around Outlook
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Press CTRL+1 for Mail 
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Press CTRL+2 for Calendar 
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Press CTRL+3 for Contacts 
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Press CTRL+4 for Tasks 
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Press CTRL+5 for Notes 
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Press CTRL+6 for Folder List 
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Press CTRL+7 for Shortcuts 

Shortcuts for Mail



Action

Keyboard Shortcut

Move between panes in window

F6 (SHIFT+F6 to go backwards)

Move between folders

CTRL+Y

Open a new message

CTRL+SHIFT+M or CTRL+N

Move around fields in a new Message window

TAB (or SHIFT+TAB)

Look up an e–mail address

CTRL+SHIFT+B

Check the validity of an address that you've typed

CTRL+K

Format selected text

Use standard formatting shortcuts, for example, CTRL+B for bold

Send message

ALT+S 

Open next item

CTRL+COMMA

Open previous item

CTRL+PERIOD

Reply to a message

CTRL+R 

Reply All

CTRL+SHIFT+R 

Forward a message

CTRL+F

Delete a message

CTRL+D

Permanently delete a message

SHIFT+DELETE

Move a message

CTRL+SHIFT+V

Move around a folder tree

The arrow keys

Create a new folder

CTRL+SHIFT+E

Shortcuts for Attachments



Add an attachment    On the Insert menu (ALT+I) use the File command (F). 

Add another e–mail message as an attachment with Word as your e–mail editor    

· Open a new message (CTRL+SHIFT+M). 

· Press CTRL+TAB to get to the Mail toolbar. 

· Use either the TAB or RIGHT ARROW keys to move the focus to the Insert File button [image: image55.png]


. 

· Press the DOWN ARROW key. 

· Now either press E or the DOWN ARROW key and ENTER to select Item. 

· Find the message you want to attach, then select OK. 

Add another e–mail message as an attachment if Word isn't your e-mail editor   On the Insert menu (ALT+I) use the Item command (E).

Open an attachment from a closed message    In a folder, select the message which has the attachment, press SHIFT+F10, select View Attachments by pressing H, use the ARROW keys to select the required attachments (there could be more than one), then press ENTER to open the attachment.

Read an attachment in an RTF message    The attachment will appear in the body of the message. Move to the attachment using the arrow keys, select it using SHIFT+ arrow key, press SHIFT+F10 to open the shortcut menu, select Open by pressing O.

Read an attachment in plain text or HTML messages    From the open message, press SHIFT+TAB to move into the attachment area of the message header, select the attachment with SHIFT+LEFT ARROW key, press SHIFT+F10 to display the shortcut menu, type O for Open.

Save an attachment    From the open message, use the Save Attachments command (N) on the File menu (ALT+F).

Shortcuts for Calendar



Action

Keyboard Shortcut

Change calendar to week

ALT+HYPHEN

Change calendar to month

ALT+EQUAL SIGN

Change calendar to see specific number of days

ALT+ number of days (for example, ALT+5 shows five days)

Move to a specific date

CTRL+G

Create a new appointment

CTRL+SHIFT+A or CTRL+N 

Create a new meeting request

CTRL+SHIFT+Q

Send a meeting request 

ALT+S

Save and close an appointment

ALT+S

Accept a meeting request

ALT+C

Tentatively accept a meeting request

ALT+N

Decline a meeting request

ALT+D

Delete a meeting request

CTRL+D

Shortcuts for Contacts



Action

Keyboard Shortcut

Create a new contact

CTRL+SHIFT+C

Find a contact

F11

Save and close a contact

ALT+S

Delete a contact

CTRL+D

Bottom of Form
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